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RESUMO:  O  objetivo  do  trabalho  é  elaborar  uma  metodologia  e  a  avaliação  para  o  software 
Photomodeler no uso do levantamento cadastral do patrimônio histórico edificado. O baixo custo dos 
equipamentos envolvidos, pouco pessoal empregado, agilidade são algumas vantagens deste perante 
os outros métodos de cadastro. Como exemplo, utilizamos o método na “Nova Casa do Comandante” 
Fortaleza de Santa Cruz, localizada na ilha de Anhatomirim, na cidade de Governador Celso Ramos. 
Para isto utilizamos: uma máquina fotográfica MITSUCA Ds8333BR (câmera de bolso), uma trena de 
vinte metros, um tripé p/ máquina fotográfica,  Software  Photomodeler 5 Pro, Computador Pentium 4, 
1Gb de memória  RAM e 100Gb de memória  rígida.  Tal  trabalho  gerou um modelo virtual  em três 
dimensões  e  exportado  para  diferentes  tipos  de  softwares e  utilizado  na  aplicação  de  cadastro, 
pesquisa, ensino, exposição (internet), entre outros.

Palavras Chave: Fotogrametria a curta distância, Photomodeler, patrimônio histórico.

1. Introdução

O objetivo  principal  deste  trabalho  é  disseminar  as  técnicas  de fotogrametria,  utilizando um software 
específico,  no auxílio ao cadastro, conservação e restauração de monumentos históricos.   O software 
Photomodeler traz a grande vantagem de não necessitar caros equipamentos e ser de fácil manuseio. 
Seus processos e ferramentas automatizados tornam os trabalhos muito produtivos. No Brasil, a escassez 
de recursos faz com que o cadastro destes monumentos sejam a garantia que um futuro processo de 
restauração  resgate  com  fidelidade  as  originais  características  do  monumento.  A  criação  do  Arquivo 
Fotogramétrico do Patrimônio Histórico e Cultural Brasileiro foi proposta pela primeira vez em 1992, sendo 
que a necessidade de se estabelecer uma regulamentação técnica foi então aprovada em 1993, quando 
da  realização  do  XVI  Congresso  Brasileiro  de  Cartografia.  No  ano  seguinte,  convocaram-se  os 
intervenientes e interessados em participar e desenvolver o Anteprojeto do Cadastro Fotogramétrico de 
Monumentos Históricos no Brasil, apresentado durante o XVII Congresso da SBC, em 1995. 

2. Fundamentação teórica

2.1. Fotogrametria

É a ciência e tecnologia de obter informações confiáveis através de processos de registro, interpretação e 
medições de imagens. Encontra seu maior campo de atuação na elaboração de mapas em colaboração 
com  outras  ciências  como  Geodésia  e  Cartografia.  Tem  como  objetivo  a  reconstrução  do  Espaço 
Tridimensional (espaço objeto), a partir de imagens bidimensionais (espaço imagem) (Brito, 2000). 
A  Fotogrametria  Terrestre  consiste  nas  atividades  de  captação  de  dados  gráficos  por  meio  da 
Fotogrametria  utilizando  como  sensor  uma  câmara  métrica  terrestre.  As  finalidades  deste  tipo  de 
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levantamento são as investigações para obtenção relações precisas  entre  objetos  e componentes do 
objeto imageado para serviços especializados de medição e controle de deformações,  restauração de 
patrimônio arquitetônico ou de engenharia civil, restauração de monumentos e arqueologia. 
A fotogrametria como método de medição, tem uma série de vantagens sobre as técnicas de levantamento 
clássico a trena, a saber: 

• o objeto não é tocado durante a medição; 
• a aquisição rápida de grandes volumes de dados; 
• os fotogramas armazenam grandes quantidades de informações semânticas e geométricas; 
• as fotografias são documentos legais, refletindo a época de sua obtenção; 
• podem ser medidos movimentos e deformações (avaliação temporal); 
• os fotogramas podem ser avaliados a qualquer momento, podendo a medição ser repetida várias 

vezes; 
• a precisão pode ser aumentada de acordo com as necessidades articulares de cada projeto; 
• superfícies  complicadas  e  movimentos  podem ser  facilmente  determinados  com  a  densidade 

desejada; 
• a estereoscopia é a base para o traçado dos contornos dos objetos. 

Nem sempre o projeto arquitetônico original,  conforme está esboçado em planta (quando esta existe), 
confere  com  os  atuais  detalhes  e  medidas  da  edificação.  O  resultado  provido  pelo  levantamento 
fotogramétrico  de  uma estrutura  traz vantagens na medida em que  a representa  da forma  como  se 
encontra  no  momento  de  obtenção  das  fotografias.  A  obtenção  das  características  desta  edificação 
quando de sua construção só podem ser obtidas pela procura em documentos literários que retratem o 
estilo e época em que se elevou o monumento (Renuncio e Loch, 1997). Outra razão para o emprego de 
fotogrametria  é  quando  um  edifício  não  pode  ser  levantado  por  topografia  convencional,  ou  mesmo 
manualmente, quer em função de limitações de tempo, ou mesmo quando seu estado de fragilidade não 
lhe permite ser tocado. 

3. Photomodeler

3.1. Calibração da Câmera

Antes iniciar qualquer trabalho, deve-se calibrar a câmera no software. Na pasta em que o foi instalado o 
Photomodeler existe o arquivo PhotoModelerCalibrationGrid.pdf. Neste encontra-se uma folha em tamanho 
A4 com a grade de calibração. Será necessário imprimir uma cópia desta, que será utilizada logo mais.
Abrindo o software e clicando em File – New project aparecerá esta tela:

Fig 1 – New Project

Selecione a opção Photomodeler Calibration project -> Next -> Next. Aparecerá uma caixa de texto onde 
você deverá nomiar sua máquina fotográfica e então pressione Next. 
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Fig 2 – Nome da câmera 

Em seguida, irá perguntar se foi utilizado o zoom no trabalho. Independente da resposta, a câmera deverá 
sempre trabalhar no mesmo zoom. Quando muda-se este, muda-se também a distância focal, porém o 
software só reconhece uma distância focal por máquina. O que deve se proceder no uso de diferentes 
zoom é repetir o processo de calibração para cada zoom, nomeado diferentemente cada um. No passo 
seguinte temos a opção de escolher qual tipo de câmera a ser utilizada (digital, 35mm, Polaroid, etc).

Feito isto o software pedirá onde estão localizados os arquivos das imagens da folha de calibração.

Fig 3 – Imagens de calibração

A  folha,  previamente  impressa,  deverá  ser  colocada  sobre  uma  superfície  lisa,  de  onde  deverá  ser 
fotografada de diferentes posições e ângulos. O software aconselha que tal procedimento seja feito com 
uso de tripé, para que não haja tremor nas fotos. Também deverá obtidas entre 6 a 12 fotos, para que o 
software consiga adquirir todos os parâmetros necessários. Salve suas imagens para a calibração em uma 
pasta conhecida. 

Clique em Add/Remove Image(s) -> Change diretory  e selecione o diretório onde você salvou as imagens
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Fig 4 – Selecionando imagens para calibração

Clique em All para selecionar todas ou selecione uma por uma. -> Ok. -> Next  -> Finish.
A tela a seguir aparecerá

Fig 5 – Execução de calibração

O passo seguinte será executar a calibração clicando em  Execute Calibration, na caixa de mensagem 
aberta no centro da tela. A calibração se dará automaticamente, levando alguns minutos dependendo da 
qualidade da imagem. 
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Fig 6 – Calibração Automática

Terminando este processo, feche a janela interna clicando em Close e salve o projeto, clicando em File-
>Save project e dando o nome ao arquivo a ser criado (Exemplo: sony.pmr). A calibração está pronta e o 
arquivo criado possui os dados da câmera.

3.2. Levantamento Fotográfico

Definida  a  máquina  fotográfica  a  ser  usada,  o  levantamento  fotogramétrico  necessita  das  fotografias 
obtidas das fachadas, telhados e detalhes tal que haja uma sobreposição onde os pontos em comum 
estejam, em pelo menos, três fotos.

As imagens adquiridas devem preferencialmente ter  a mesma distancia  do objeto,  devido a correção 
luminosa automática da câmera.  Uma imagem obtida mais  longe muda a textura do objeto.  Para um 
trabalho com muitos detalhes pequenos, o ideal seria obter fotos da mesma distância usando o zoom da 
máquina e calibrando esta como outra máquina.
 
A câmera deverá ser mantida mais estável possível para que não ocorra a distorção na imagem. Para isto 
usa-se o tripé.

Em campo, deve-se obter uma medida de controle, para que o software reconheça a distância real dos 
objetos. Para este, existe dois métodos:

• Método da distancia conhecida: com trena descobre-se a distância entre dois pontos conhecidos. 
A partir deste conhece-se automaticamente os outros.

• Método  das  coordenadas  conhecidas:  conhecendo-se  dois  ou  mais  coordenadas  de  pontos 
(pontos de controle) do objeto por métodos topográficos (estação total ou teodolito) descobrem-se 
as medidas do objeto.

O método topográfico possui a vantagem de poder-se georreferenciar o objeto, ou seja, fazer a localização 
espacial  na  Terra.  Já  o  outro  pode  baratear  o  levantamento,  não  necessitando  de  estação  total  ou 
teodolito.

4. Objeto de Estudo

A escolha do objeto levou em consideração aspectos de fácil acessibilidade e parcerias entre instituições 
dentro  da  Universidade  Federal  de  Santa  Catarina.  Por  isto,  uma  edificação  das  fortalezas  (Ilha  de 
Anhatomirim,  Ratones,  etc)  localizadas  próximas  ou  em  Florianópolis  será  usada  no  levantamento 
fotogramétrico. Para Ilha de Anhatomirim, em especial, existem viagens diárias de funcionários da UFSC, 
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sendo  de  acesso  fácil  e  livre  aos  pesquisadores.  A  Fortaleza  de  Santa  Cruz,  localizada  na  Ilha  de 
Anhatomirim, hoje na área de jurisdição do município de Governador Celso Ramos, está estrategicamente 
situada na entrada da Baía Norte. Configurava no século XVIII um dos vértices do sistema triangular de 
defesa idealizada pelo Brigadeiro Silva Paes. Sua construção teve início em 1739 e foi concluída cinco 
anos mais tarde. Sua arquitetura tem traços de influência renascentista. Fica em uma ilha com espessas 
muralhas e seus edifícios se distribuem de maneira esparsa em diferentes níveis. A maioria dos materiais 
utilizados na sua construção é da própria região com exceção feita aos elementos de cantaria e ao “lioz” – 
espécie  de  mármore  português  existente  nas  soleiras  das  portas,  escadarias  e  algumas  bases  dos 
canhões (www.fortalezas.ufsc.br). O Projeto Fortalezas trabalham no restauro, manutenção e visitação de 
tais fortes. 

Figura 7: Ilha e Fortaleza de Anhatomirim

A Nova Casa do Comandante, edificação escolhida para este trabalho, foi edificada por volta de 1895, no 
local onde existiu a Capela da Fortaleza, demolida para dar lugar a esta construção. Nela moraram o 
comandante e o médico da fortificação. 

Figura 8: Nova Casa do Comandante
http://www.photografos.com.br/exibirfoto.asp?id=118578

5. Iniciando o Projeto

Executando o Photomodeler, iniciamos um novo projeto em:
File ->  New Project -> A Standart PhotoModeler Project -> Next -> Next
O software pede agora a unidade de dimensão a ser usada e a maior dimensão aproximada do objeto. A 
dimensão utilizada será em metros e a unidade aproximada é vinte metros. Next
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Figura 9: Parâmetros de projeto – janela 01

A seguir, será necessário definir a câmera. Como a calibração já foi feita e salva em arquivo, selecionamos 
a opção  A calibrated  camera  or  a  previously  used in  Photomodeler. Na  próxima  janela,  existirá  dois 
campos: o de cima, para usar uma câmera de um projeto já existente e, o de baixo, para buscar o arquivo 
de calibração. Clicando em Browse, selecionamos o arquivo previamente criado (*.pmr). Next.
Assim, abre-se uma janela contendo os parâmetros da câmera. Next.
Devemos então adicionar as fotos obtidas em campo: Add/Remove Images...
Neste momento selecione apenas três fotos (Figura 10) e assim que o projeto for evoluindo, adicione mais 
fotos. Next -> Next -> Finished.

Figura 10: Fotos iniciais do projeto

A partir de agora se inicia o processo de vetorização das imagens. Os pontos, linhas e curvas em comum 
nas imagens deverão ser marcados e ligados entre as imagens. Após estas marcações, devemos fazer o 
software processar o trabalho, para então demarcarmos as faces.

Para auxiliar na marcação, a ferramenta de zoom pode ser utilizada de duas maneiras. A roda central do 
mouse ou com a tecla  Alt – posicione o mouse sobre a uma região e aperte. A segunda opção é muito 
interessante pois agiliza muito o trabalho na prática.
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Figura 11: Zoom local (tecla Alt)

5.1. PONTOS

Iniciamos todos os projetos pelos pontos. A partir destes conseguimos referenciar as fotos entre elas. Para 
que as imagens sejam referenciadas umas as outras devemos:

o Referenciar seis pontos desta em outra foto
o Referenciar três pontos que estejam referenciadas, pelo menos, em outras duas fotos.

Com um duplo clique na imagem número 1, a imagem abrirá. Clicando em  Mark Points Mode  ou 
apertando o número 2 (dois) do teclado, ativamos a marcação dos pontos.
Como exemplo marcaremos as molduras nas janelas. Todos os pontos possuem um número (ID). 

Figura 12: Marcação dos primeiros pontos
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Este processo pode ser repetido infinitas vezes ao longo do projeto. Assim pode-se começar pelos objetos 
maiores e terminar nos detalhes.

Agora começamos a referenciar os pontos e, para isto clicamos em Reference mode , ou apertamos a 
tecla R. Abrirá uma nova aba, onde iremos informar a imagem de referência,  a qual o ponto já esta 
marcado, e a imagem de destino, onde será marcado. 

Figura 13: Modo de referência

Selecionando uma imagem de destino, esta aparecerá em uma janela ao lado da imagem de referência. 
Selecionando os pontos, posicionamos o mouse sobre a imagem de destino, aparecerá o ponto a ser referenciado 
em amarelo na imagem de referência. Fazendo isto para todos os pontos, automaticamente passará para a próxima 
imagem. Os mesmos pontos não devem ser referenciados em muitas imagens, pois há a maior propagação de erros. 
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Figura 14: Referenciando os pontos

5.2. LINHAS

A linha é definida como uma reta que vai de um ponto a outro. Assim, o processo de criação de linhas 

pode ser feito ligando pontos já definidos ou criando novos pontos. Ao clicar em Mark Line mode , ou 
pressionando a tecla  [4],  podemos definir  a  reta.  Com esta  ferramenta podemos clicar  em pontos já 
existentes ou criar novos pontos.

Figura 15: Definindo as linhas

10 / 17



COBRAC 2008 · Congresso Brasileiro de Cadastro Técnico Multifinalitário · UFSC Florianópolis · 19 a 23 de Outubro 2008 

5.3. CURVAS

Os elementos curvos podem ser definidos pela ferramenta Mark Curves Mode , ou apertando a tecla 
[7].  Deve-se ir clicando nas bordas do elemento, tornando mais parecido com o objeto o possível.  As 
curvas devem ser marcadas nas imagens antes de serem referenciadas. Como exemplo foi criado uma 
curva feita por uma rachadura no chão, em frente a porta.

5.4. PROCESSANDO

O processamento consiste  em ajustar  os pontos através  de métodos estatísticos,  determinando seus 
desvios padrões. Caso este for muito grande, o software acusará e para prosseguir deverá ser corrigido o 

ponto problemático. Para processar o projeto clicamos em Process , ou pressionar a tecla [F5]. Abrirá 
uma janela com sugestões. Então aperte em Process.

Figura 16: Processamento OK

5.5. FACES

As faces são, assim como as linhas, delimitados por pontos. Para facilitar a visualização clicamos em 

Open a 3D viewer, , ou pressionando [F7]. Na aba Visibility, selecione Points, Lines, Surfaces – Fast 
Textures, Ok.
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Figura 17: Opções de visualização

Aparecerá, em vista 3D, as linhas delimitadas pelas molduras das janelas. Clicando em Path Mode, , 
clique nos pontos que definem o plano e terminando clique no botão direito e Finish Surface.

Figura 18: Criação das Faces

5.6. DEFININDO ESCALA

Para definirmos todas as medidas do objeto, definimos a partir da distancia de dois pontos conhecidos. 
Clicando em Project – Scale/Rotate... – Scale. Em Distance, preencha com o valor obtido da medição em 
campo. Selecione os dois pontos e clique em Define.
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Figura 19: Criação das Faces

6. Exportando o Projeto

Existe a possibilidade de exportar o projeto por:

6.1. ORTOFOTO

Uma  ortofoto  é  uma  imagem  fotográfica  que  foi  retificada  diferencialmente  para  remover  qualquer 
distorção de geometria (posição e inclinação) e deslocamentos devido ao relevo.
Para obtermos uma ortofoto de uma fachada clica-se em 

File -> Export Ortho Photo...

A ortofoto é definida apartir de um plano (a fachada). Para isto precisamos definir três pontos da fachada. 
Do exmplo, escolhe-se os pontos 1, 2 e 4, números correspondentes a moldura das janelas. Em Project 
Plane clicando  em  3 points,  defini-se  o  plano  e  as  origens  dos  eixos.  Clicando  em  Update  preview 
visualiza-se uma miniatura da ortofoto. Clicando em Export, basta definir a pasta e o nome do arquivo . Tif.

Figura 20: Criação da Ortofoto 
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6.2. MODELO TRIDIMENSIONAL

Existem diferentes tipos de extensões de arquivos que o PhotoModeler exporta: .dxf, .3ds, .wrl, .obj, etc. 
Aponta-se como principais as extensões dxf e 3ds:

Formato DXF
Este formato possibilita o uso do projeto em modo vetorial (AUTOCAD), utilizado para fazer medições, 
cadastro, plantas baixas, etc.

Formato 3DS
Neste podemos visualizar o objeto virtual com suas texturas, muito utilizado para a animação gráfica.

Para obtermos uma ortofoto de uma fachada clica-se em 
File -> Export Model...
Clicando em Ok, basta escolher o nome do arquivo e pasta de destino.

Figura 21: Criação do Modelo Tridimensional 

7. Conclusão

O levantamento da edificação gerou o objeto em 3D.
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Figura 22 : Objeto em 3D

Neste trabalho as fotos foram obtidas de diferentes distâncias do objeto. Isto deve ser evitado para que 
não haja diferença de luminosidade, consequentemente as texturas das faces entre as imagens mudam. 

Figura 23 : Diferença das texturas

Como medida de base medimos em campo a distancia entre a quina da borda inferior da moldura da 
janela mais a esquerda até a da janela mais a direita. A distância medida foi de 10,041 metros
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Figura 24: Distância Base

A tabela abaixo mostra algumas comparações dos erros obtidos

Dimensão Medido em 
Campo

Medido pelo 
software

Erro Erro percentual(%)

Afastamento da moldura da 
parede 0,018 0,012 0,006 33,33
Base da moldura 1,432 1,437 -0,005 0,35
Base do medidor de luz 0,400 0,390 0,010 2,50
Pilar de sustentação 3,612 3,597 0,015 0,42

Tabela 01: Comparações das distâncias

Nota-se que o erro está numa faixa de 0 a 2 cm. Devemos considerar que neste trabalho a distância das 
fotos obtidas até o objeto foi, em média, 10 metros. Alguns fatores podem ser relevantes para a diminuição 
do erro como:

• Qualidade da máquina
• Qualidade da foto (bem posicionada, totalmente sem ruído na imagem)
• Acuidade visual
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Figura 25 :  Modelo Vetorizado
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